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Nucleons

Working from: W. Wilcox, T. Draper, K.-F. Liu, Phys. Rev.
D46(1992) 1109-1122 (hep-1at/9205015) — notation changed
slightly. Also they use a different (Dirac) spin basis from us.

The interpolating operators for the nucleon are:

Xo(® )ZEC”?CUZ( r)ug(2)Cpyds (2)
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Where:

C‘:O»)/5

1s the charge conjugation matrix. In our spin basis for QDP we
have

C = vpy2 = Gamma (10)
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Two point function:
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di-quark piece
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The Di-Quark Piece

= Tr [CN’DW (, O)CN’_lUCC, (, O)}

—  Tr DY (2,0)01U (x, 0)(’3]

Ty (C‘Dbb’(x,O))T(Uccl(zc,O)CN’)}

- T
L bb’ cc’
— TI' ( Oéﬁ) R67:|

= Tr |QULR |

Thomas Jefferson National Accelerator Facility

@



Having Contractions...

/
Ea,bc a'b’ ¢ {Qaa bb

By

R

index1 index2 index3 index4

In QDP-++:

quarkContractXY( Q@ , R )

contracts spin indices X and Y as well as the epsilons e.g: above

quarkContractl3( Q, R )
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So the Full Nucleon

e Prior to Fourier Transform for momenta - from chroma:
— file: lib/meas/hadron/baryon_w.cc

C~1 E u ) ~F
(0,0>Ed > — (xt)

LatticeComplex nucl2pt (const LatticePropagator& quark_ propagator,

const SpinMatrix& T, const SpinMatrix& sp)

LatticePropagator di_quark = quarkContractl3 (quark_propagator * sp,
sp * quark_propagator);

return LatticeComplex (trace (T * traceColor (quark_ propagator *

traceSpin(di_quark)))

+| trace (T * traceColor (quark_propagator * di_quark)));

} /

di-quark piece ,
three quark piece
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http://usqcd.jlab.org/usqcd-software/chroma/chroma/docs/doxygen/html/namespaceChroma_1_1StaggeredFlavorOperators.html#8fdb9e9bf6a65d6b986c91d47517eeaf

1/0

e [ will discuss 2 kinds of I/O here:
— Reading/Writing Parameters (and simple data)

— Reading/Writing Lattice Quantities (QIO)
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Reading and Writing Parameters

e Itis generally useful, to not have to rewrite our main-
programs every time we need to change parameters.

» Preferable to read the parameters from a file
e Parameter file can be

— Flat: e.g.: <parameter>=<value> pairs

— Structured:

e somehow the parameters follow the 'structure' of the
classes they parameterize...

— Interface Description Languages like Sun RPC
— Structured Markup:

» Fortran Namelists ( old...)

» XML ( currently fashionable )
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A tale of two parameter files

" FlatFile:

6\

Lx=4

Ly=4

Lz=4

Lt=8
StartType=DISORDERED
beta=5.4
Mass=0.02
MaxCG=500
RsdCG=1.0e-8
n_steps=16
traj_length=1

.

e & Structured Markup >

<?7xml version='1,0' encoding="UTF-8'?>
<Params>
<lattSize>
<Lx>4</Lx>
<Ly>4</Ly>
<Lz>4</L.z>
<Lt>8</Lt>
</lattSize>
<config>
<cfgType>DISORDERED</cfgType>
</config>
<HMC>
<monomials>
<wilsonGauge>
<beta>5.4</beta>
</wilsonGauge>

™
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Advantages/Disadvantages

e Advantages of Flat Files

— Easy to write your own
parser

— Quite Dense files
e Disadvantages
— Can be pretty inflexible

e Suppose you add
something completely
new

o Are there name clashes?

e Do you have to introduce
rules for the meanings of
names?

.geffégnn Lab
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e Advantages of Markup
— Follow your class structure
— More flexible if well designed

* A new class is just a new
section of markup

— Can do flat files if you really
want..

* Disadvantages
— Quite Verbose
e whats with the <> anyway?

— You probably don't want to write
the parser

e force use of 3" party libraries
like libxml2
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Once you go down the XML path...

e In QDP++ for various considerations, we opted to use XML
e Qur experiences:
— XML is great for parameter files
— XML is OK for writing simple data
e Plaquettes, HMC energies, etc.
— XML 1s good 1n principle for writing out highly
structured ouput data
e eg: Momentum Channels, Operators, etc

e In practice this highly structured output data was very
difficult to process for analysis:

— HUMONGOUS FILES
— Takes a long time to extract desired subset
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Reading / Processing XML in QDP++

e The main input XML handling class in QDP++ is:

XMLReader

 An XMLReader will
— read and parse an XML document
— allow the interrogation of the document via XPath

IIXNZHOdE\\\\\*<?xml version="1.0" encoding="UTF-8"7?>
<bar>

from root: /foo/bar/fred }/y <fred>6</fred>

from foo/bar: ./fred <jim>7 8 9</jim>

</bar>

</foo>
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Reading/Processing XML in QDP++

e Opening and reading the file:
XMLReader xml_in(“./my xml file.xml”);
e Reading Elements:

int fred;
multild<int> jim;
read( xml_in, “/foo/bar/fred”, fred);

read( xml_in, “/foo/bar/3jim”, jim);
e Switching Context (cd —1ing ) :

XMLReader new_reader (xml in, “/foo/bar”);

read ( new_reader, “./jim”, jim);

} Thomas Jefferson National Accelerator Facilit
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Except for the Exceptions

e Suppose you ask for a file/path that does not exist?

e XMLReader will “throw a C++ exception”
— All XML Reader exceptions are of type std::string
— It 1s your responsibility to “catch” these.

— So typically the code for XML processing will look more
like:
int fred;
try {
XMLReader xml_in(“./my xml file.xml”);
read( xml in, “/foo/bar/fred”, fred);
}
catch( const std::string& e) {
QODPIO: :cerr << “Caught Exception: “ << e << endl;
QDP_abort (1) ;
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Exercise/Homework:

e Change the gcd.cc code in Example 3 so that
— It reads the run time parameters from a file
e Try the following flat approach first:

e Then try adding some (. @ An XML Flat File >
StruCture <?xml version='1,0' encoding="UTF-8'?>
<Params>
<Lx>4</Lx>
<Ly>4</Ly>
Remember: S
The XMLReader is part of STy IS ORDERED el Type>
QDP++. Make sure you've
called QDP_initialize() before B S
2 <trajLength>1.0</trajLength>
you use 1t“‘ <nuinH1\/g[CTrj>500<J/nunigHMCTrj>
</Params>
( 4
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Writing XML

 We have an XML Writer Class XMLWriter
— This class 1s abstract. There are 2 derivations:
* XMLFileWriter - write to a file
* XMLBufferWriter — write a documet “in memory”
— A writer can do three things:
e Open/ Close Tags for a Group
e Write a leaf element
e “Paste in” the contents of an XMILReader
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e (Creating a writer

XMLFileWriter

e Open a group tag

push (xml_out,

Writing XML
xml_ out (“./output_file);

“foo”); <foo>

e Write an element
Real t=Real(0.5); <t>0.5</t>

write (xml _out, “t”, t);

e C(Close a group tag

pop (xm_out) ;

e (lose writer

</foo>

xml out.close();
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Exercise: Logging the HMC...

e Use XML to log the plaquette measurement in the HMC
code from exercise 3.

e Advanced:

— Use XML to log the energies, acceptance probabilities,
etc from the HMC code.

— Hints:
* You may need to change the operator() in HMCTrj to
allow the passing of an XMLWriter

e Here you may consider using a global variable for the
HMC log, to leave the interfaces unchanged.

* What happens to the log if your HMC crashes? (You
can simulate this by hitting Ctrl*C while the code 1s
running. Is XML Ideal for logging?)
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Reading/Writing Configurations/Props

e (learly XML 1s not a good way to write out really big things
e Binary 1s preferable

e However, it can be useful, to attach some information to the
binary to tell us about its contents

— Lattice Size, Byte order, datatype (system stuff)
— How the contents were computed (user stuff)

e The SciDAC software committee developed a file format to
do just this

e Along with the format came a library called QIO to
manipulate the files.

e Here I will present the QDP++ interface to QIO,
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LIME

Private File XML Data e Lime files contain:
User File XML Data } HEADER

— A header

— One or more messages
Message 1 .
Record 1 e Each Message contains
— One or more Logical
records
M e Each record contains
essage 1
Record 2 — Private XML Data
— User XML Data
— Binary data
User Record XML Data > Message 2 ° Header has
Record Binary Data Record 1 — Private XML Data
— User XML Data

Checksum Record

= Thomas Jefferson National Accelerator Facili
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What goes in the Records?

e Private records
— Datatype, Byte order etc
— YOU DON'T WRITE THESE. QIO does 1t automatically
e Checksum records
— QIO Writes these.
e User records
— You do write these
e User XML comes from an XMLBufferWriter
e Binary comes from your QDP++ Lattice Datatype

e Writing non Lattice Types 1s possible (global data
feature of QIO) but awkward...
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QIO Interface

* Write with gDPFileWriter e Read with QDPFileReader

e User File XML and User
Record XML returned in
XMLReader

e Checksum/ILDG details

e Must supply user file and user
record XML as
XMLBufferWriter

LatticeFermion my_lattice_fermion;

push(file_metadata, "file_metadata"); .
write(file_metadata, "annotation", "File Info"); CheCked lntemally
pop (file_metadata) ; < @ | File XML

QDPFileWriter out ( /

file_name,

. TN
[QIO Write QDPIO_SINGLEFILE,
:7’ QDPIO_SERIAL); XMLReader record_in_xmIj;
MOde FIagS Record XML QDPFileReader in( ’
XMLBufferWriter record_metadata; file_name,
push (record_metadata, "record_metadata"); QDPIO_SERIAL) ;
write (record_metadata, "annotation", "Record Info");
pop (record_metadata) ; atticeFermion my_lattice_fermion;
out.write( record_metadata, my_lattice_fermion); in.read(record_in_xml,
out.close(); my_lattice_fermion);
in.close();
- Thom fferson National Accelerator Facili N
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Three modes for reading/writing

Q Q QDPIO_PARTFILE

e Pl

-— 0

QDPIO_SINGLEFILE

@ 1/0 process . »@
‘ Writing/Reading

non 1I/O
Q process QDPIO_MULTIFILE p atterns for

QDPIO_SERIAL
o e e
11C
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Three modes for reading/writing

‘o

QDPIO_SINGLEFILE

o

QDPIO_PARTFILE

B

@ 1/0 process @ . ‘»@

QDPIO_MULTIFILE

oL -0 e~

Writing/Reading
patterns for
QDPIO_PARALLEL
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QDP++ and QIO

e QDP++ Currently supports the SINGLEFILE and
MULTIFILE formats for QDPIO_SERIAL

 PARTFILE has been tried occasionally but is not supported
* You can use QIO independently of QDP++ of course

e Recently the SciDAC committee has been trying to
“standardize” the contents of User-Records for

— Configurations
— Propagators

— BUT (thankfully) the software does not constrain you to
comply with this.
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Exercises’ Homework:

e Change the QCD code of exercise 3 to dump the gauge
configuration every now and again. You should then set up the
parameter reader of the last exercise, to read the frequency of
saving the configurations from the parameter file.

* Modity QCD code of exercise 3 so that it has the option for 3
kinds of gauge startup (driven from the parameter file):

— ORDERED, DISORDERED, FROM_FILE

e Modity the propagator code of exercise 2, to read its input
configurations from a file

e Generate 100 trajectories without saving, and then another 100
trajectories, saving every 10" trajectory

e Compute the pion correlator on the last 10 configs you saved

} Thomas Jefferson National Accelerator Facilit 5
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Final Words about 1/0

e [ guess the I/0 sector of QDP++ still needs work
— Interfacing to/testing more advanced QIO features
— Better support for writing out non-lattice types
 eg: Correlation functions.
— Do we really need to write files at all???
 Why not dump directly into some database?
— Ah! But who will operate the database?
— ... <Your future Technology trends go here >
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“The Network is the Computer”

e Suppose you are working in a small collaboration and don't
have the resources to produce your own configuration.

e Never fear! There are many configurations you can get for
free.

* From
— The Gauge Connection
— The Brookhaven Configuration Archive
— CP-PACS Archive
— International Lattice Data Grid

} Thomas Jefferson National Accelerator Facilit 5 3
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The Gauge Connection

* [s aweb based archive, based at NERSC :
— http://qcd.nersc.gov

* You can browse the datasets and read about them, select the one you
want and download it.

* You can perform mass downloads using the wget utility

* You need to register, to get a username and a password.

e Configurations come 1n “QCD Archive Format” a.k.a NERSC
Format.

* QDP++ can read/write NERSC format through the functions:

void readArchiv (multild<LatticeColorMatrix>& u, const string& cfg_ file);

void writeArchiv (const multild<LatticeColorMatrix>& u, const string& cfg_file);

e Archive has code to read the files, in case you don't like QDP++

} Thomas Jefferson National Accelerator Facilit 5 3
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http://qcd.nersc.gov/

QCDOC Lattice Archive

e A similar archive to the NERSC one, hosted by Brookhaven
National Lab, to share the Domain Wall Configurations

produced by QCDOC
— http://lattices.qcdoc.bnl.gov
e Some configurations completely freely available

e Others are restricted to members of USQCD and require a
username and password

* Files are in the NERSC format

B Thomas Jefferson National Accelerator Facilit 5N
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http://lattices.qcdoc.bnl.gov/

Lattice QCD Archive

e Hosted as part of the Japanese Lattice Data Grid

— http://www.jldg.org/lga provides a web front end
e Currently requires registration to use
» Files are formatted in the ILDG format

— Thas 1s just the LIME format with a particular set of
records. QDP++ should be able to read these.

} Thomas Jefferson National Accelerator Facilit
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The International Lattice Data Grid

e The International Lattice Data Grid (ILDG) is trying to
define standards to make data sharing more easy (essentially

it 1s an infrastructure group)

— Standardized Metadata for information about
configurations

— Standardized File Format (LIME)

— Standardized Middleware Architecture to assist:
e Data Discovery (discovering the ensembles you want)
e Data Location (finding the corresponding files)
e Data Transfer (to download the data)

e Major Players: CSSM (Australia), LDG (Europe),
QCDGrd/DiGS (UK), JLDG (Japan), USQCD, ...

} Thomas Jefferson National Accelerator Facilit 5
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ILDG Architecture

Step 0: Register in the ILDG VO

 VoMsRSSerer > VVOMSRS Service

Step 1: Lookup ensemble &
configurations by metadata

% 'éﬂ_]' Metadata
— Catalogue
=! ;

lookup (MDC) VOMSRS Server

_ will manage one
Returns: LFN or more VOMS

SErvers

Step 2: Locate configuration by LFN

l , Repli

I

I

I

I

I

I

I

I

| ——— Iookup (RC)
| .
I

I

I

I

I

I

o
- Retums: UL ———"" =
Step 3: Initiate download of URL VOMS
http server
Returns: File GridF TP server | | Storage
N — Element
T Config SRM server
¥y File
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Using the ILDG

 You'll need
— An acceptable X509 grid certificate
— A whole bunch of Grid tools
e LDG supplies a complete set (LTOOLS):
— http://www-zeuthen.desy.de/latfor/ldg/doc/

* You'll need to register your Certificate in the ILDG Virtual
Organisation at:

— https://grid-voms2.desy.de:8443/vo/ildg/vomsrs
* You can browse the metadata catalogs online, via the web.

* You can download files with the 1ldg-get utility (in
LTOOLS)
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Metadata Catalogues

e Various implementations / Web portals should allow you to
explore data in multiple catalogues.

— USQCD: http://usqcd.jlab.org/mdc-web-client/index.jsp
— LDG: http://www-zeuthen.desy.de/latfor/ldg/

— CSSM: http://cssm.sasr.edu.au/ildg/

 Some MDCs may be slow (perhaps trying to contact non-
existent databases) or 'partially functional' (in
Development ).
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Comments on the ILDG

e Some parts of the ILDG are more mature than others

— LDG: verbgy mature with many many configurations
online. In production use.

— Some other regional grids have not yet developed to the
same extent (no names!)

— But important milestones in interfaces and
interoperability have been reached in the past year

— We expect more maturation as time progresses.
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